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1 Microsoft Office 
Point People: Tawney Knecht (tknecht@uoregon.edu) and Grace Lindquist 
(glindqui@uoregon.edu) 

 

1.1 Homework and In-Class Assignments 

Before class (due at the start of the workshop):  

• Download Microsoft Office 
• In Excel: 

o You will be provided an Excel file containing FTIR data on Canvas. 
Create a scatter plot of this data set in Excel, following the tutorial in 
section 1.4. You do not need to change the settings of the graph to look 
nice yet as we will do this in class; just make a graph.  

o Save the file and be prepared to edit in class. 
 

In class:  
• Make a presentation-ready graph of the provided data following the primer below 

(section 1.4). 
• Save the graph template 
• Paste your graph into a Microsoft PowerPoint slide.  

 
Homework (due at the start of the following week):   

• A single PowerPoint slide (*.pptx) with an appropriately-sized graph.  
o Include slide number and an assertive title (example of good and bad title 

is found in the PowerPoint primer, section 1.3) 
• Follow this format for your file submission: LastName_FirstName_Graph.pptx.  

 

1.2 Download Instructions 

Go to the following website: https://software.uoregon.edu/ 

Log in with your DuckID 
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Navigate to the Software Center (left menu): 

 
Input the system you are using: 

 
Click on either “Microsoft Office 2016 for Windows/Mac” or “Microsoft Office 365”: 

 
Click on “Obtaining Software” link and follow instructions. 

 

 

1.3 Basics of Microsoft PowerPoint 

You will give many presentations over your graduate career, and PowerPoint is the 
preferred presentation software. This primer is not meant to be an extensive overview of 
PowerPoint, but rather a list of tips that may be helpful in making presentations.  

 

1.3.1 General Presentation Guidelines 

This guide will provide several general tips for good presentations, but please note 
that you should ALWAYS defer to your PI’s preferences for making a good 
presentation. Remember, the goal is to communicate your science effectively to your 
audience. 

In general, follow these rules: 

• Sans serif fonts (Arial is a generally accepted font choice) 
• Main text font sizes no smaller than 16 pt 
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• Minimal text on slides 
o Any text should help the audience follow the presentation, not distract 

them from what you are saying 
o Bullet points are often more helpful than full sentences 

• No dark backgrounds 
• No unnecessary or distracting graphics 
• Slide numbers in bottom right corner (always include slide numbers) 

o To insert, go to the Insert tab and click on the  icon in the “Text” 
section of the toolbar 

o Check “Slide Number” and click “Apply to All” 
• Slide titles should be assertions and highlight the conclusion of the slide 

o Example of bad title: FTIR Data 
o Example of good title: FTIR data indicate monomer is consumed during 

reaction 
 

1.3.2 Slide Master 

Slide Master is a way for you to create a template of a presentation design that you 
can apply to future presentations to save you time. In this, you can select fonts, font 
sizes, change placement of text boxes, and create simple but professional designs.  

To start, go to the View tab and click “Slide Master” 

 
Under Fonts, choose your preferred font (Arial will be used in this guide) 

 
In the second slide, arrange textboxes so they fill the space appropriately, and change 
the font sizes if necessary. 
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If desired, add simple design features. Common examples include colored boxes at 
the bottom in which to put references, or a line at the top to separate the title from the 
rest of the slide. Examples are shown below, created using the box and line shapes 
(a section on shapes is below). Be careful to not overdo this step and be open to 
feedback from PIs and other students if they feel the design features are unnecessary 
and/or distracting.  

  
To save the theme to apply to future presentations, go to the Slide Master tab, click 
on “Themes” dropdown and click “Save Current Theme.” 

 
Save in the desired folder. To access this theme later, open a new presentation, go to 
the Design tab, and click through the themes. The theme you saved should appear in 
this list. 
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1.3.3 Shapes 

To insert a shape, go to the Insert tab, click on the “Shapes” dropdown and select the 
shape you want to draw.  

 
Once a shape is drawn, you can edit the fill color (“Shape Fill”) and outline color and 
thickness (“Shape Outline”) in the Format tab.  

 
Use the “Align” dropdown in the Format tab to align shapes in an aesthetically pleasing 
manner.  
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Helpful tips for drawing shapes: 

• Notice that lines will appear in PowerPoint when you move shapes around to 
help you align them in an aesthetically pleasing manner 

• Select multiple shapes by either clicking and dragging your cursor to form a 
box around them, or by pressing CTRL while clicking on multiple shapes 

• Group shapes by selecting multiple shapes, right clicking, and selecting 
“Group.” Shortcut: CTRL+G 

• Move shapes or groups of shapes to the front or back by right clicking on 
shapes and selecting one of the following: 

o Move to front 
o Move to back 
o Move forward 
o Move backward 

• Holding SHIFT while drawing a line/arrow will keep the arrow perfectly 
horizontal or vertical as you draw it 

• Holding SHIFT while scaling a shape will lock its aspect ratio 
• Holding SHIFT while moving a shape will restrict the movement to only the 

horizontal and vertical directions (helpful for alignment of multiple shapes) 
• Holding CTRL while moving a shape will duplicate that shape 
• Holding SHIFT while you rotate a shape will rotate it by 15° at a time 

 

1.3.4 Animations 

Animating in textboxes, shapes, and/or figures can be helpful in presentations to 
prevent too much information being presented all at once. To animate in an object, 
select the object, go to the Animations tab, and select “Appear.” Do not use distracting 
animations. 
 

 
You can also make objects disappear by selecting “Disappear” under the same 
dropdown. 

To manage animations, click on “Animation Pane” 
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This will open up a menu on the right of the slide listing all of the animations on that 
slide. Using this pane, you can change the order of animations, as well as whether the 
animation starts “On Click” (will not appear until you click) or “Start with Previous” (will 
appear with previous object, allowing you to group that animation). 

 
 

1.4 Basics of Microsoft Excel 

 
There is a myriad of resources online to help with Excel, so this guide will only point out a 
few helpful tips that you may commonly use. 
 

1.4.1 Inserting Data 

Several data sets already come as Excel files, others may come as .csv files. To insert 
from a .csv file, hit CTRL+A in the .csv file to select all of the data, hit CTRL+C to 
copy, go into Excel and select a cell and then hit CTRL+V to paste. 

 

1.4.2 Text to Columns 

Often, pasting data from a .csv file pastes all of the data into a single cell. To separate 
numbers into different cells, go to the Data tab and click “Text to Columns.” 

 



12 
 

 
A window will appear. Depending on the data format, you will select “Delimited” if data 
are separated by commas, spaces, or tabs, and you will select “Fixed width” if data 
are aligned. “Delimited” is more common. Click “Next.” 

 
 
Select your delimiters and check the Data Preview to ensure the data are separated 
the way you need, then click “Finish.” 

 
 
 
 

1.4.3 Highlighting Data 

To highlight data, simply click and drag over the data you need. For large data sets, 
you can also hit CTRL+SHIFT+Arrow Key [fhgi] to highlight data to the end of the 
data set in the direction of the arrow you pressed. 
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1.4.4 Inserting Formulas 

A good resource if you are new to formulas is here:   

https://corporatefinanceinstitute.com/resources/excel/study/basic-excel-formulas-
beginners/ 

The general format of a formula is “=Operation(Cell#:Cell#)” 

For example, if I want to add numbers in cells A1 through A10, the formula would be 
“=SUM(A1:A10)” 

Common formulas: 

• Addition: =SUM(data range) 
• Average: =AVERAGE(data range) 
• Standard Deviation: =STDEV(data range) 
• Minimum: =MIN(data range) 
• Maximum: =MAX(data range) 
• Division (for example, cell A1 divided by A2): =A1/A2 
• Multiplication (for example, cell A1 times A2): =A1*A2 

To select the data range, either drag over the desired data when prompted, highlight 
the data as discussed previously, or manually type in the data range. 

 

1.4.5 Making a Graph 

Please see section 3.3 in the Igor Pro tutorial for elements of a good graph. Many 
groups may prefer you use other software to make graphs, but Excel is a good starting 
point, and it is possible to make professional-looking graphs in Excel. Please defer to 
your mentors and PIs’ expectations for making graphs, the following is only meant 
to show you the features that can be used in Excel. 

For an example, the following data will be used to make a graph: 

 
To make a graph, first determine what type of graph you need (scatter, line, bar, etc.). 
For this example, a scatter plot will be used. Select the graph type from the Insert tab 
in the “Charts” section.  
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A blank graph will appear. Right click on the graph and select “Select Data.” A new 
window will pop up. Click Add. 

 
A new window will pop up where you can name your data (useful when graphing 
multiple data sets) and select the X and Y values of the data set. Here, I will plot 
Sample 1 with X values as A1:A10 and Y values as B1:B10. I will then plot Sample 2 
with X values as A1:A10 and Y values as C1:C10. To select X values, click on the h 
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next to the “Series X values:” line, then highlight the desired data. Do the same for the 
Y values. Hit OK on all windows. 

 

 
The graph should now look like this: 

 
Delete gridlines by clicking on the gridlines and hitting “Delete” on your keyboard. 
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Add axis titles by selecting the green plus sign at the top right of the graph when you 
click on the graph. Select “Axis Titles.” 

 
Edit the axis titles by simply clicking on them and typing. You can adjust the color, font, 
and font size by operating in the Home tab. You can also do this for the axis numbers 
by clicking on those numbers. In this example, axis titles were changed to Arial 14, 
black and axis numbers changed to Arial 12, black.  
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Edit the axes by first clicking on the axis numbers (this example will start with the X-
axis). A menu should pop up to the right of the screen. In this window you can change 
the axis range, among other features. Play around to see what each item does. In this 
example, X-axis range was changed to have a minimum of 0, maximum of 10, major 
unit as 2.0, and the Y-axis range was changed to have a minimum of 0, maximum of 
20, major unit as 5.0. Under “Tick Marks” the major tick marks were selected to be 
outside. 

 
With the axis still selected, click on the paint bucket to change the thickness and 
color of the line. In this example, lines were selected to be black with a thickness of 
1.5. 
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To close the axes, click on the chart area such that just the chart area inside the axes 
(not the whole chart) is selected. On the right, the “Format Plot Area” menu should 
appear. Under “Border” select “Solid line” and change the settings. In this example the 
border was chosen to be black with a thickness of 1.5.  

   
To add lines of fit, select a point in the data set, right click, and select “Add Trendline.” 
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In the “Format Trendline” menu on the right, scroll to the bottom and check the boxes 
next to “Display Equation on chart” and “Display R-squared value on chart.” 

 
Edit the text font by clicking on the equation and editing using the Home tab. In this 
example, it was changed to Arial 14. 
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This guide did not go through all of the features in the formatting menu that appears 
when you double click on the chart or axes. Please click through all of the menu 
items to see what can be edited, and how they affect the chart. If you have questions 
about how to edit something, please first search for help online and then contact 
Tawney if you need additional help. 

 

1.4.6 Saving and Applying Chart Templates 
Now that you’ve created a professional-looking chart, you can save these settings 
and apply them to future graphs to save some time and keep your graphs consistent. 

 

Resource: https://www.excelcampus.com/charts/chart-templates-default-formatting/ 

 

To save a template, follow these steps: 

1. Make a chart with all of the desired formatting features (please defer to your 
mentors’ and PI’s preferences) 

2. Right click on the chart and select “Save as Template…” 
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3. Save template file in the default folder as desired file name. 

 

To apply templates, follow these steps: 

1. Make a new chart 

2. Right click on the chart and select “Change Chart Type…” 

 
3. A window will appear. Select “Templates” from the left column and select the 

desired template. Hit OK. 
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4. Note that this will not affect the size of your chart. For consistency, resize your 

chart using the Format tab and entering the desired height and width of your 
chart. 4” height and 4.8” width are good starting points, but again, defer to your 
PI’s and mentors’ preferences.  
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2 MestReNova 
Point people: Kiana Kawamura (kkawamu2@uoregon.edu) and Josh Barker 
(jbarker@uoregon.edu)  

NMR Facilities Director: Nanette Jarenwattananon (njaren@uoregon.edu)  

 

2.1 Homework and In-Class Assignments 

Before class (due at the start of the workshop):  
• Follow Download Instructions for MestReNova (detailed below).   
• Follow Steps 1-2 of the MestReNova primer below (open the provided raw data 

file in MestReNova). 
 

In class:  
• Follow Steps 3-7 in the MestReNova Primer below.  

 
Homework (due at the start of the following week):  

• A MestReNova file (*.mnova) with the proper settings and a worked up 1H NMR 
spectrum for the data file provided (1-allylnapthalene). Follow this format for your 
file submisstion: LastName_FirstName_Mnova_HW.mnova.  

• A single PowerPoint slide (*.pptx) with an annotated NMR spectrum for the 
provided data file and compound (see Step 6 for what this should generally look 
like). Follow this format for your file submission: 
LastName_FirstName_Mnova_HW.pptx.  

 

2.2 Download Instructions 

1. Go to http://hotwax.uoregon.edu/mnova  

2. Read the PDF installation guidelines: 
http://hotwax.uoregon.edu/mnova/MestReNova_Installation_Instructions.pdf  (this should 
fix 99% of problems that come up during installation of MestReNova) 

3. Follow instructions for downloading and installing MestReNova 

 



24 
 

 

 

2.3 Using MestReNova 
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2.4 Other Notes and Tips 

• Always compare product NMR spectra to starting material spectra 
• Think about which peaks you expect to disappear/appear/shift going from starting 

material to product 
• Check the “Common 1H NMR impurities” list to see if impurities are from solvents that 

you used during the reaction (or during work-up!) 
• Pay attention to splitting when assigning peaks (i.e. if a proton has two neighboring 

protons, it should be a triplet) 
• Remember that you need to take NMR spectra in the same solvent to compare 

chemical shifts (i.e. if you have an NMR spectra of your starting material in CDCl3, you 
should take an NMR spectra of your product also in CDCl3) unless solubility prevents 
this 

• The AIST structural database has NMR spectral data for a wide range of common 
starting materials (https://sdbs.db.aist.go.jp/sdbs/cgi-bin/cre_index.cgi)  

 

2.5 Supplementary Resources 

• Alternative MestReNova tutorial: 
https://www2.chem.wisc.edu/~cic/nmr/Guides/Other/Mnova_NMR_Training_for_chemist
s_on_1D_and_2D_NMR-Version_8.0.pdf 

• Common NMR chemical shifts (1H, 13C, 19F, 31P, 77Se) organized by functional group: 
https://organicchemistrydata.org/hansreich/resources/nmr/?index=nmr_index%2F1H_shi
ft 

• Common 1H NMR impurities (list of chemical shifts for solvents/common impurities for 
most relevant NMR solvents): https://pubs.acs.org/doi/pdf/10.1021/om100106e 
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3 ChemDraw 
Point Person: Kiana Kawamura (kkawamu2@uoregon.edu) 

 

3.1 Homework and In-Class Assignments 

 
Before class (due at the start of the workshop):  

• Follow Steps 0-2 in the ChemDraw Primer below (downloading ChemDraw 
software and initial set up).  

• Draw the following reaction scheme in ChemDraw. We will work on editing the 
individual structures and overall reaction during the in-class workshop.  

 

• OPTIONAL: If you want a challenge, you can work on making the following 
organometallic synthesis reaction scheme.  

 

 
In class:  

• Follow Steps 3-8 in the ChemDraw Primer below.  
 

 
Homework (due at the start of the following week):  

• A ChemDraw file (*.cdx) with the proper settings and one example reaction 
drawn out (can be an example from class or one from your rotation). Follow this 
format for your file submission: LastName_FirstName_ChemDraw_HW.cdx.  

 

 

 

 

 

 

 

 

OH
+ Br K2CO3

acetone, reflux, 
8 h

O

MgCl + NN

iPr

iPriPr

iPr
NiCl2 (anhyd)

THF, 50 °C, 4 h
N2

Ni
N

N
dipp

dipp

2
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3.2 Download Instructions 
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3.3 Using ChemDraw 
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44 
 

4 Igor Pro 
Point Person: Tawney Knecht (tknecht@uoregon.edu) 

 

4.1 Download Instructions 

 

• Go to the following website:  
 

https://www.wavemetrics.com/order/order_igordownloads.htm 
 

• Click on either Igor8.dmg (for Macs) or setupIgor8.exe (for Windows) 
• Follow the prompts to install Igor 
• Use the following license information when prompted: 

 
Serial number: 80120 
Activation key: NGNA-DJZM-ASVP-UJMZ-KSSS-UNDE-ZPP  
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4.2 Elements of a good graph 

A good graph has the following features: 

• Data is appropriately represented in accordance with the literature (i.e. use 
example plots from the literature to guide your graphing) 

• Data fill the space that is given 
• Data are easy to interpret 

For example, if you have multiple traces on the same graph, either color-
code them and ensure the colors are different enough to be able to easily 
distinguish or use markers to denote the different traces. Keep in mind color 
contrast for color-blind folks. 

• Axes are properly labelled, with units 
• Text is large enough to read 
• Axes use scientific notation, where appropriate 
• No distracting/unnecessary information or graphics 
• Aesthetically pleasing (use the literature and examples to guide this) 

o No gridlines 
o Proper aspect ratio 
o Mirrored axes 
o Lots of other components that will come with time and practice… 

Example of a bad graph: 

 

Example of a good graph using the same data, plotted in Igor Pro: 
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4.3 How to Make a Graph in Igor Pro 

 

4.3.1 Pasting data into Igor Pro from Excel 

 
You can paste data directly into Igor from most files, but it is generally easier to 
start in Microsoft Excel, and then copy and paste from there. With your data in 
excel, first create a unique label for each column. Note that Igor will not allow you 
to paste in more than one column with the same name, so make sure each column 
has its own label. To create a row above the data in Excel, highlight the top row, 
right click and select “Insert.” Then create unique labels for each column. In the 
example data, there are two sets of IR data, with the first two columns being the y-
values (absorbance) and the third column being the x-values (wavenumber). I have 
chosen to label them as shown below: 
 

 
 
Next, select all of your data in Excel either by clicking CTRL+A to select all, or 
highlight the top row of data (including the titles) and clicking CTRL+SHIFT+i.  
 
Once desired data is selected, click CTRL + C to copy the data, go into Igor, select 
the top left box in the table, and click CTRL + V to paste the data. The table should 
look like this: 
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4.3.2 Creating a Graph 

 
To do this, go to the Windows tab and select “New Graph…” 
A window will pop up (shown below).  

 

In the XWave column, select your desired X-values. In the YWave(s) column, 
select your desired Y-values. You can select multiple (if they have the same X-
values) by holding down CTRL as you click on them.  

Hit Add in the top center of the window, and then click Do It at the bottom left. You 
should then have a graph that looks like this: 
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4.3.3 Editing the Graph 

 
Disclaimer: this guide will walk you through how to edit all of the features of a 
graph. The goal of this guide is not to show you how to make a graph look a specific 
way, just to show you how to edit all of the features, so please defer to your 
mentors and PIs for what constitutes an acceptable graph for 
presentations/publications.  
 
To edit the graph, double click on one of the axes. A window will pop up with all of 
the parameters you can change to edit the graph. This guide will go through all of 
the tabs in the following instructions. As you change settings in this window, watch 
how it affects your graph. 
 

4.3.3.1 Axis 

 

In the first tab, you can change the appearance of your axes. In the top left, 
you select which axes you are affecting (x, y, or both). In the image above, 
it says “Multiple Selection…” because both axes are selected. 

The Mode section is where you can change your axis to a log scale, which 
is useful in many situations, but not for this example.  

The Axis section is where you change the appearance of your axes. For 
this example, I unchecked the “Axis standoff” box, selected “No ticks” from 
the Mirror Axis dropdown, and changed “Axis Thick” to 2. 

The Font section is where you change the axis label and title color, size, 
and font. The default is Arial, which I left unchanged. I changed the size to 
20 and left the colors black. 
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4.3.3.2 Auto/Man Ticks 

 

Here is where you change roughly how many numbers you want on your 
graph, as well as how many ticks. In the Automatic Ticks section, I 
changed the ticks to be approximately 5, and I checked the “Minor Ticks” 
and changed the “Minimum Sep” to 10. These are good values with which 
to start, but these numbers will depend on the specific data. Play around 
with different values to see how these numbers affect your graph. Also note 
that you may need to change these for each individual axis, in which case 
you need to change which axis you are affecting by selecting the 
appropriate axis from the Axis dropdown menu in the top left corner of the 
window.  

 

4.3.3.3 Ticks and Grids 

 
These settings rarely need to be changed. In the Exponential labels 
section, you can change from “Engineering” to “Scientific,” and you can 
determine how many decimal places are included by changing the high trip 
and the low trip. For this set of data, the default values work well.  
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In the Tick Dimensions section, you can change whether the ticks are on 
the inside or outside, and you can change the length and thickness of the 
ticks. In this example, I left the location on “Outside” and left the rest as 
“Auto.” 

 

4.3.3.4 Tick Options 

 
These settings rarely need to be changed, but this is where you can change 
how much of your axis contains ticks. Generally, ticks will span the entire 
length of the axis, so you will keep the “Enable ticks between” to -infinity 
and infinity.  

 

4.3.3.5 Axis Label 
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Select your font and font size. Once you change anything, code will appear 
in the Axis Label box. Note that this code will affect anything after, but not 
before, the code. When selecting a font size, \Z## will appear. So to change 
the font to 20, \Z20 appears in the box, and a preview is shown below it. 

For superscripts or subscripts, select which you want from the “Special” 
dropdown menu. For subscripts, \B will appear. For superscripts, \S will 
appear. After you type your sub/superscript, exit out by selecting “normal” 
from the “Special” dropdown menu and \M will appear. Again, select the 
font size you want and finish typing your title and units. Examples are 
shown in the images above. You can also change the style (bold or italics) 
as well as the text color from the “Special” dropdown menu and insert 
special characters or symbols. Explore this on your own to see what the 
“Special” dropdown offers. 

As a shortcut, you can also type the code directly into the Axis Label box. 
Some common codes are listed below (case-sensitive): 

• \Z[insert font size] = changing the font size 
• \S = superscript 
• \B = subscript 
• \M = normal (i.e. exit out of sub/superscript) 
• \f00 = no style (i.e. exit out of bold or italics) 
• \f01 = bold 
• \f02 = italics 
• \f03 = bold and italics 
• \JC = justify center 
• \JL = justify left 
• \JR = justify right 
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4.3.3.6 Label Options 

 
These settings rarely need to be changed. Here you can change the 
rotation of your axis title, as well as the axis labels themselves.  

 

4.3.3.7 Axis Range 
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Change your axis range to be something appropriate. In the Autoscale 
Settings, this is where you can reverse your axis if necessary (not 
necessary for this data set). You can also select “Round to nice values” 
from the first dropdown, or you can manually set your axis limits in the 
Manual Range Settings box. The settings I chose for this data set are 
shown in the figures above.  

Hit Do It. If you’ve changed all of your settings to this example, the graph 
should look like this: 

 

 

4.3.4 Editing the Traces 

 
To edit the traces, double click on one of the traces and you should get the 
following window: 
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Select which trace you want to affect in the Trace box. Then you can change 
several features such as the line size, the line style, and the color. You can also 
offset traces by checking the “Offset” box and typing in how much you want to 
offset x and y. Additionally, this is where you can change the Mode, which is 
generally “Lines between points” or “Markers.” This depends on the specific data 
set, as well as how that data is generally plotted. Defer to your mentors, PIs, and 
the literature for guidance on this.  

For this example, I changed the line size to 2.00 for both traces and changed the 
Y_A trace to be black and the Y_B trace to be maroon. Use colors you feel are 
appropriate. Hit Do It.  

 

4.3.5 Changing the Graph Size 

Double click on white space in the graph window, but outside of the actual graph. 
You should get the following window: 

 

This is a matter of what aspect ratio looks best for your data, as well as personal 
preference. I changed the Width mode to Aspect and changed it to 1.2*height. I 
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then changed the Height mode to “Absolute” and chose 4 (inches). Play around 
with these settings to see how each affect your graph.  

Hit Do It. If you’re following along, your graph should look like this: 

 
 

4.3.6 Adding Annotations 

 
To add annotations, either a legend or text, right click on the graph and select “Add 
Annotation…”. You will get the following window: 

 

To simply add text, type in the Annotation box. The same codes as previously 
discussed related to font size, sub/superscripts, etc. apply here.  

To make a legend, select “Legend” from the Annotation dropdown menu in the 
top left corner, and you will get the following window: 
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Edit the labels as well as the font size. I labeled mine as “Sample A” and “Sample 
B” with a font size of 20, as shown below: 

 

NOTE: many PIs prefer you not use legends, but instead label the data directly. 
Please defer to PI preferences when making graphs. 

In the Frame tab, you can put a box around your annotation, change the 
background color, and more. Play around with these settings to see what they do.  

In the Position tab, you can rotate the annotation. Again, play around with the 
settings to see what they do.  

 

4.3.7 Duplicating the Graph 

To duplicate the graph, select the Edit tab from the top of the Igor window and 
select “Duplicate Window.” Note that you can also click CTRL+D as a shortcut. 
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4.3.8 Saving Graphics 

To save graphics, select the window that you want to save, go to File and select 
“Save Graphics.”  

 

Select the format and resolution. I generally save them as TIFF Files at 8X screen 
resolution for presentation-quality graphics. I save at 16X screen resolution for 
publications. After you click Do It, you will be prompted to select the destination in 
which you want to save the graphics, similar to saving any other file.  

 

4.4 Capturing Graph Preferences 

Now that you have a graph that looks professional, you can save these preferences 
so that new graphs generated always have the same settings. 

To do this, make sure the graph window is selected, go to the Graph tab and select 
“Capture graph prefs…”. Check all of the features you want to be saved (an example 
is shown below) and click “Capture Prefs.” 
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4.5 How to Make a Graph Macro 

Graph macros are similar to capturing graph preferences but can be more specific (i.e. 
include axis labels for specific types of data), saving time if you have common types of 
data that you frequently work up. Here’s how to do it:  

First, notice that there is a window of code in Igor that records all of your actions, shown 
here: 
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Copy the actions you want to have in your macro. NOTE: Actions applied to your specific 
traces ((Y_A) and (Y_B) in my case for this example) should not be copied, otherwise the 
macro will not work for data with different labels. Only copy things that can be applied 
generally.  

Open a new procedure window by selecting Windows à Procedure Windows à 
Procedure Window.  

On the second line of the procedure window, type the following, including spaces:  

Proc name of procedure() : GraphStyle 

For example, if I want my procedure to be named “General,” I would type the following:  

Proc General() : GraphStyle 

Then, starting in line 3, paste the actions you want in the procedure into the new procedure 
window. If you like all of the actions from this tutorial, the procedure window will look 
something like this: 
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Notice that things like setting the axis range were not copied since that is specific to the 
current data and is not generally applicable to all data. You can, however, make multiple 
graph macros to use for multiple types of data.  

Save the procedure by clicking File à Save procedure copy… 

When you download Igor, it should install a folder called “Igor Procedures.” I’d 
recommend saving the procedure in there as the desired name of the procedure.  

Save your project and restart Igor.  

To apply your macro in the future, make a graph (following this guide up to step 3b) and 
with the graph window selected go to Windows à Graph Macros à Your Procedure and 
all of your settings should be applied to that graph. 
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5 Adobe Illustrator 
Point Person: Grace Lindquist (glindqui@uoregon.edu) 

5.1 Homework and In-Class Assignments 

Before Class (due at the start of the workshop): 

• Download Microsoft PowerPoint (see Microsoft Office primer) 
• Make and save a theme using PowerPoint Master Slide (see Microsoft Office 

primer) 
• Download Adobe Illustrator and start a new file (steps 1 and 2 in below primer) 
• Save this file under a name and location you can easily find and open in class 
• Using any combination of the PowerPoint and Illustrator tools described in these 

primers, start creating a scientific figure related to your current rotation project. If 
you do not know your rotation project yet, create a figure related to an 
undergraduate research project or laboratory assignment.  

 

In Class: 

• Come with any questions or confusion you have and we will work through them 
• Continue working on your figure 
• Discuss how to improve the following figure using use both PowerPoint and 

Illustrator: 

 
 
Homework (due at the start of the following week):   

• Finish your figure 
• Export it as a high resolution (300 ppi) jpeg (if made in Adobe Illustrator) 
• Import this into a PowerPoint slide  

o Apply the theme that you made for homework  
o Size figure appropriately for a presentation 

• Turn in PowerPoint slide with the file name format 
LastName_FirstName_Figures.pptx 
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5.2 Why Use Adobe Illustrator for Scientific Figures? 
 

For designing any image, a user must first decide which graphic format to use. The two common 
choices are Raster graphics and Vector graphics. Raster graphics are bitmaps, which is to say 
the image is a grid of individual pixels. The pixels have locations (x and y coordinates) but do not 
have any specific relationship to each other. Vector graphic are algorithmic, which is to say the 
lines/shapes/text are based on mathematical formulas. Lines/shapes/images do not have fixed 
locations but are rendered from calculation and are related to other objects mathematically. 
Compared to Raster, Vector graphics are easier to manipulate, can be scaled indefinitely, and 
will match the output resolution of any device. Vector graphics are generally smaller in size due 
to the luxury of not memorizing every single pixel. For most scientific figures Vector graphic design 
is the better choice; figures created in this format will materialize quicker, be easier to edit, and 
will be aesthetically appealing in more situations.  

The difference becomes clear when zooming in on an inserted Raster vs Vector graphic in a 
document. The two figures below are the same Illustrator file. Image A was inserted as a Vector 
image (svg) while Image B was inserted as a Raster (jpeg). The difference is not visible zoomed 
out, but close up it becomes obvious. 

Image A      Image B 

 

Closeup 
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5.3 A Brief Note on Graphic Design 
 

This document is a small primer on the basics of graphic tools in Adobe Illustrator. These are the 
simplest tools, in the author’s eyes, that constitute a good foundation for new users. This 
document doesn’t say anything about the process of making graphics or really how to design a 
graphic. Those things could realistically be another 20 pages or more apiece. 

A word of advice from an old teacher, a man who makes beautiful graphics. His advice is “always 
answer the why question. Answer it about every single detail of the graphic.” 

Example: 

• Why did you put a line on the document? It represents the ligand of a nanoparticle. 
• Why is the line stroke 4 points? It is supposed to be ~4x as large as the other ligands 

which have strokes of 1 point. 
• Why is the line 30 points long? Because the nanoparticle is 30 points wide and so they 

are symmetric in some sense. 
• Why is the line where it is? Because it’s part of an array of 6 other lines each spaced 60° 

around the nanoparticle. It’s in this position to maintain symmetry which looks aesthetically 
pleasing. Also, the entire image is horizontal and vertical centered to improve symmetry. 

• Why is the line that shade of blue? The ligand absorbs red light, also that shade of blue 
complements the nanoparticle’s shade of red and the 2nd ligand’s shade of green. 

Answering these types of questions will improve your end graphic immensely and inevitably lead 
to discovering more powerful design tools.  
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5.4 How to download Adobe Illustrator 

The Adobe Creative Cloud suite is available to all faculty, staff, and department student 
employees. This primer focuses on Adobe Illustrator, but all Adobe Creative Cloud applications 
(Photoshop, Acrobat, InDesign, etc.) are available to you. 

To download Adobe Illustrator: 

1. Visit this CASIT link: https://casit.uoregon.edu/faq/overview-of-adobe-creative-cloud-
application 

2. Scroll to “Installing the Adobe Creative Cloud desktop application” and click the link to 
“Adobe Creative Cloud desktop application page” 

3. Follow the site step-by-step instructions to log in with your UO ID 

 

5.5 Basic Document Setup 

Initial Setup 

Creating a new document in Adobe Illustrator is accomplished using Clt+N or by going to the File 
menu and clicking New Document. Since Illustrator is a Vector graphic program, document sizing 
need not be a primary concern at this point. However, if the user is interested in quantitative 
graphic design, I highly recommend using Points as the preferred Units (image 1). The preferred 
Units can be changed at any point during the graphic design, but Points will facilitate more precise 
relationships between objects. 
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Image 1. New Document configuration dialog box. 

 

Editing the document preferred Units can be accomplished by the shortcut Clt+K or by navigating 
the Edit menu to Preferences and General… (image 2). Once at the Preferences dialogue box 
navigate to the Units tab change the preferred Units (image 3). 

 
 

 

Image 2. General Preferences menu navigation. 

 

 

 

Image 3. The Units tab in the Preferences dialog box. 
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Resizing after Document Setup 

The composition space in Adobe Illustrator is known as an Artboard. Artboards can be added or 
edited after document setup by using the shortcut Clt+Alt+P or by navigating the File menu to 
Document Setup…. On the Document Setup dialogue box click Edit Artboards to access the editor 
(image 4). 

 
 

Image 4. Document Setup dialog box. 

 

The Edit Artboard button returns the user to the composition space and generates a transform 
box around the initial Artboard (image 5). Additional Artboards can be generated by clicking the 
paper button (blue arrow) or deleted by clicking the trash can (red arrow). Artboards can also be 
named by clicking the desired Artboard and then typing a name into the text box (green arrow). 
Pressing the escape key will close the editor and save your changes. 
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Image 5. The Artboard editor. 

 

5.6 Handy Adobe Illustrator Shortcuts and Tricks 
 

Learning a few Illustrator shortcuts can greatly increase work output and decrease user 
frustration. Since they apply to almost every situation, this section will cover the primary shortcuts 
used for selection and workspace navigation. Brief summary: press V to select entire objects, 
press A to select portions of objects, press Ctrl+Shift+A to deselect everything, press Alt and use 
the scroll wheel to zoom out/in, and press spacebar to reposition the stage. 

Selection Key Presses (V, A, and Ctrl+Shift+A) 
 

To generally select objects in Illustrator the Selection Tool can be used. This is the solid black 
arrow on the upper side of the tools toolbar. Clicking with this tool will select entire objects, 
grouped objects, and any related properties (e.g. fill color). By contrast, the Direct Selection Tool 
will only select the Path or Anchor Point that is being clicked on. Consider the square in image 6, 
if the upper right corner is selected with the Selection Tool the entire shape is selected. If the 
upper right corner is selected with the Direct Selection Tool only the upper right Anchor Point is 
selected. 
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Image 6. (Left) Upper right point of square selected with Selection Tool (Center) Upper right point of square selected 
with Direct Selection Tool (Right) Selection Tool and Direction Selection Tool menu icons. 

 

The Selection Tool can be activated by pressing V on the keyboard, whereas Direct Selection 
Tool can be activated by pressing A. Alternatively, with one tool already selected, the other can 
be activated by pressing down the Ctrl key (Command for Mac). Generally speaking, selected 
objects/lines/points can be deselected by clicking an empty region of the Artboard. If the Artboard 
is sufficiently cluttered deselection can also be achieved using the keyboard shortcut Ctrl+Shift+A. 

 

Workspace Navigation Key Presses (Space and Alt+Scroll) 
 

It is likely, given use of other image manipulation programs, that you’ll initially default to the 
magnifying tool and scroll bars for workspace navigation. These solutions work, however there 
are two ways to significantly expedite workspace navigation. First, holding down spacebar will 
transform the cursor into a hand; clicking and dragging with the hand repositions your view of the 
Artboard (note: this does not change any Artboard coordinates). Second, holding down the Alt 
key and then scrolling the mouse scroll wheel will zoom in and out on your workspace. Note: For 
users without scroll wheels, holding the Alt key converts the magnifying glass “zoom in” mode to 
“zoom out” mode. 
 

5.7 Layer Control 
 

For a mildly complex scientific figure (e.g. a band bending diagram) it is not uncommon for the 
final Illustrator document (.ai file) to include 100+ objects (e.g. paths, shapes, text, lines). The 
question becomes, how does the user effectively organize this information in a way that facilitates 
the presentation and future editing needs? The answer is Layers. 

Layers are work organization constructs which can contain objects in Adobe Illustrator. Consider 
that Adobe Illustrator is similar in some ways to a physical sketchbook. For the analogy to be apt 
this must be a sketchbook in which the front cover and each page is transparent. We could say 
that each page of the sketchbook is a Layer. If you draw a circle on the first page (first Layer) and 
close the book you will see a circle through the transparent front cover. If you draw a square on 
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a page below (a lower Layer) then you will see the square unless the circle happens to be covering 
it up. Finally, each page of the sketchbook has a little tab sticking out where you can 
name/describe what that Layer contains. This tab enables you to quickly find/edit a select part of 
the overall graphic. 

Layers allow the user to logically organize the separate pieces of the graphic. Layers also control 
which objects appear above/below others and can be used to hide pieces of the graphic which 
are not actively being worked on. By default, the Layers window (image 7) will be in the lower 
right-hand corner of the screen; if missing it can be activated by pressing F7 or by navigating the 
File menu to Layers. New Layers can be added by clicking the new page icon (blue arrow). Layers 
can be renamed by double clicking on the name (red arrow). An object is added to a Layer by first 
selecting the Layer and then drawing the object on an Artboard. If multiple objects are drawn on 
the same Layer a Sub-Layer will be generated for each one. Sub-Layers can be effectively used 
to group and organize similar objects. New Sub-Layers can be manually created by clicking the 
new page + arrow icon (green arrow). 

In the example below multiple squares and circles are organized first by Layer and then by Sub-
Layer. Since the squares are on a lower Layer, the circles will cover them whenever overlap 
occurs. 

 
 

 

Image 7. Example Layer window with squares and circles organized. 

 

Notice that the small blue circle is also partially obscured by the large blue circle. This is due to 
the large blue circle existing on a higher Sub-Layer. 

Image 8 depicts a few additional useful aspects of layering. Clicking the eye next to any Layer will 
hide all of the Sub-Layers, whereas clicking the eye next to a Sub-Layer will only hide that Sub-
Layer (blue arrow). Clicking the empty space directly to the right of the eye will lock the relevant 
Layer and thereby prevent edits of that Layer (red arrow). When an object is selected a shaded 
square will appear on the far right of the Layers menu denoting which Layer and Sub-Layer that 
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object is on (green arrow). The object can be moved to a new Layer by dragging the shaded 
square to an open square. 

 
 

 

 

Image 8. Notice that all the blue circles are hidden and also the medium red square. Since the small red square is 
selected, the Squares Layer and Small Sub-Layer exhibit the small blue square. 

A well designed and maintained Layers window should be viewed as the foundation for any 
involved graphic design project. It’s readily apparent that Layers allow the user to quickly find and 
edit select content. But use of Layers has more subtle advantages in that it allows the user to edit 
select content while not disturbing nearby/overlapping content. Also, a well-organized Layers 
window will facilitate other users who might edit the graphic and will allow the primary user to 
resume editing seamlessly after an extended absence. 

5.8 Using the shape tool 

The shape tool is the 9th icon in the tools toolbar and defaults to the appearance of a square with 
solid fill. By right clicking on the icon a list of various shapes can be accessed (rectangle, rounded 
rectangle, ellipse, polygon, star, and flare). To adequately discuss shapes this section will be 
broken up into “during-creation” and “post-creation” processing. 

During-Creation Shape Tool 

To begin creating a shape the user should select their desired geometry from the shape menu. 
Once selected, clicking and dragging any location on the document will generate a ghost image 
of what the shape will look like. Dragging further will effectively expand the dimensions of the 
shape. Letting go of the click will finalize the shape on the document. But before letting go there 
are a number of options that allow manipulation of the shape. Different key presses produce 
various effects depending on which tool is being used: 

• Holding the alt key during the click+drag process will re-center the shape around the 
initially clicked point. 
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• Holding the shift key will ensure that the Rectangle Tool, Rounded Rectangle Tool, and 
Ellipse Tool all generate perfectly symmetrical shapes (i.e. a square, a rounded square, 
and a circle). 

 
• Holding the shift key while using the Polygon Tool and the Star Tool will simply orient the 

shape’s axis vertically on the Artboard. 
 

• Holding the ctrl key while using the Star Tool allows the user to change the distance 
between the tip points and the inner points. 

 
• Pressing the up key while using the Polygon Tool will increase the number of sides by 1. 

 

• Pressing the up key while using the Star Tool will increase the number of points by 1. 
 

• Pressing the up key while using the Rounded Rectangle Tool will increase the degree of 
rounding. 

 
• Pressing the down key while using the Polygon Tool will decrease the number of sides 

by 1. 
 

• Pressing the down key while using the Star Tool will decrease the number of points by 1. 
 

• Pressing the down key while using the Rounded Rectangle Tool will decrease the degree 
of rounding. 

 

Post-Creation Shape Tool 

After finalizing the shape the dimensions can be further manipulated by clicking the shape and 
dragging the Anchor Points. The Control Bar along the top of the screen can be used to further 
modify shape properties (image 9). The first box (blue arrow) is used to select the fill color of the 
shape. The second box (red arrow) is used to select the color of the outline. Both of these can be 
set to null (no fill / no stroke) if desired. The stroke panel (green arrows) allows the user to 
manipulate the stroke thickness, the width profile, and the brush definition. The transparency 
panel (yellow arrow) allows the user to set opacity of the shape. 

 
 

Image 9. First half of the Control bar. 

The Control Bar can also be used to precisely align the created shapes. The leftmost box in image 
10 can be used to toggle the frame of reference (blue arrow) between the current selection, a key 
object, or the artboard. By clicking Align to Artboard the menu expands and allows horizontal 
alignment to the left/center/right and vertical alignment to the top/center/bottom (red arrows). The 
icon with 9 boxes allows the user to select which part of the object is used for alignment (green 
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arrows); the X and Y coordinates are the coordinates of the aligned object (yellow arrows). W and 
H are used to set the height and width of object while the lock depicted between them dictates 
whether or not those two dimensions scale with each other or individually (purple arrows). 

 

 

Image 10. Second half of the Control bar. 

Examples of different properties can be seen in image 11. The red star is set to no stroke and 
rotated slightly. The ctrl key was used during creation to create sharper points and the up key was 
used to increase the number of points. The teal rounded rectangle has a 50% transparency and 
slightly more rounded corners via use of the shift key. For the polygon the down key was used to 
eliminate one side and no fill is selected. Finally, all three shapes are aligned to the vertical center 
of their composite composition space. 

 
 

 

 

Image 11. Example of various shapes created with the Shape Tool. 
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5.9 Making a 3D Shape  

To make a 3D shape, you revolve a 2D shape around its center. For example, to make a sphere, 
start with a circle. Make sure it has an outline color. Using the Direct Selection Tool (white arrow), 
select and delete one anchor point to form a half-circle (Image 12).  

Image 12: Starting from a circle, select and delete the left point. 

 

Select the half-circle, then navigate to the Effect menu to the 3D option and select Revolve…. 
(Image 13) In the Revolve menu (Image 14), make sure the Preview box is checked (Red arrow). 
Moving the box changes the angle of rotation about the axis.  

 
Image 13: Navigate to the Revolve button 
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Image 14: Revolve menu. The rotation axis and angle can be manually changed, or click and drag on the box. Note 

when adjusting coloring and transparency the surface shading will also affect color and appearance. 

 

You can make a variety of 3D shapes using this method (e.g. a cone by rotating a triangle or 
cylinder by rotating a rectangle). However, for unique shapes moving or rotating the 3D figure 
after creating it will change the axis of rotation and ruin the shape (Image 15). 

 
Image 15: A 3D shape created using Revolve rotated 90°. Rather than rotate the whole shape, the new triangle shape 
is revolved about the new center axis.  

To fix this, the 3D shape must be expanded. Select the shape, navigate to the Object menu and 
select Expand Appearance (Image 16). After doing so, the figure is isolated as a flat shape and 
can be moved. 



75 
 

 

Image 16: Object menu to Expand Appearance 

 

Image 17: 3D figure rotated 90° after Expand Appearance 
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5.10 Using the Pen Tool 

General Path Creation 

The Pen Tool’s importance in creating scientific figures is difficult to overstate. Any shape or path 
that is not of some regular geometry (which would be created with the Shape Tool) can be 
produced via this tool. The Pen Tool also enables precise control over the curvature of paths. On 
the surface the Pen Tool is straightforward to use, clicking the icon (5th tool on the Tools Menu) 
and clicking anywhere on an Artboard begins a path. A second click will continue the path by 
drawing a line to the newly generated Anchor Point; a third click will do the same and this trend 
will continue until the pen tool is deselected, the path is completed back to the initial point, or the 
esc key is clicked. During the initial generation of a path two key presses can be of use: 

� Pressing the shift key can be used to generate paths at any multiple of a 45° angle. 
 

� Holding the left mouse click at each point can be used to create curvature in the initial 
path. Doing so will produce curvature handles which can be manipulated to change the 
extent of curvature (image 18). 

 
 

 
 

 

Image 18. Anchor points are created from left to right. The second and third point were produced while holding the 
shift key to generate 0° and 45° angles. The fourth point was generated while holding the left mouse click to produce 

the curvature handles. 

Closing the path, by clicking on the initial Anchor Point, will generate a shape which can be 
manipulated as per the geometric shapes previously covered. Right clicking the Pen Tool allows 
access to three other tools: Add Anchor Point Tool, Delete Anchor Point Tool, and Anchor Point 
Tool. The effects produced by these tools are displayed in image 19. The Add Anchor Point Tool 
can be used to add a new Anchor Point to a pre-existing path (blue arrow). The Delete Anchor 
Point Tool will remove an existing Anchor Point. The Anchor Point Tool will generate curvature 
handles (if they do not already exist) on an anchor point and allow the user to manipulate them 
(red arrow). Keep in mind that the Direct Selection Tool can be used to move a single Anchor 
Point to a new location (green arrow).  
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Image 19. Same as image 18 but with 1st anchor point moved down via the Direct Selection Tool, a new anchor 
pointed added after the 1st via the New Anchor Point Tool, and the Anchor Point Tool used on the previously 3rd 

anchor point to apply curvature. 

Stroke Dialogue Box and Scissor Tool 
 

Paths can be further edited by using the Stroke dialogue box which can be accessed by navigating 
the Window menu to the Stroke option or with the shortcut Ctrl+F10. Most notably, the Stroke 
dialogue box can be used to convert the path to a dashed line, to add arrowheads to the path 
ends, and to change the weight (image 20). 

 
Image 20. The Stroke dialogue box. 

 

Editing single anchor points is straightforward, as they can be individually selected with the Direct 
Selection Tool. However, editing path segments in this way is not possible. A feasible way to 
individually edit a path segment is to have initially made the path segment its own path (and then 
connected it to the larger path). This approach requires some foresight and is not useful after the 
path has already been created. Instead, a path can be split up by using the Scissors Tool. The 
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Scissors Tool can be found by right clicking the Eraser Tool in the tools toolbar or by using the 
keyboard shortcut C. Clicking the Scissors Tool on any part of the path will generate two 
overlapping Anchor Points (or just one if you clicked an already existent Anchor Point) and divide 
the path into two new paths on either side of the click. Image 21 demonstrates use of the Scissors 
Tool and the Stroke Dialogue panel. 

 
 

 

Image 21. Accessing the Scissors Tool from the toolbar. 

 

 

 

Image 22. Scissors Tool used to break the path into two segments (blue arrow).  The Stroke Dialogue box was used 
to add a dashed line to the smaller segment (red arrow). The Stroke Dialogue box was also used to add an arrow to 

the larger line segment (green arrow). 

5.11 Using the Type Tool 
 

The type tool is relatively straightforward to use for most foreseeable scientific tasks. It can be 
accessed from the tool bar (the 7th icon from the top) or with the keyboard shortcut T. Once 
selected, clicking a location on the Artboard will initiate a text box and the user can then input 
text. The control bar features many of the same options as for shapes but with the notable addition 
of the Character Panel (image 23). The character panel can be used to select the font (blue 
arrow), select the font style (red arrow), select the font size (green arrow), align the font (yellow 
arrow), and warp or distort the font (purple arrow). An example of text warp is depicted in image 
24; there are many different warps available. 
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Image 23. The Character Panel on the Control bar. 

 
 

 

Image 24. Example of text warp using the flag preset. 

 

Type Character Dialogue Box 

As with strokes, there is a dialogue box for characters which gives the user finer control over the 
vector image. The Type Character dialogue box can be accessed with the keyboard shortcut 
Ctrl+T or by navigating the Window Menu to Type and then Character. Most notably, the Type 
Character dialogue box allows the user to add subscripts, superscripts, and underlines. Although 
it may be necessary to click the button in the upper right of the dialogue box to gain access to 
these options (image 25). 

 
 

 

Image 25. The Type Character dialogue box before and after “show options”. 

 

Eyedropper Tool (Text Use) 

In many programs the Eyedropper Tool is used for sampling color palettes. While it maintains that 
functionality in Adobe Illustrator it can also be used to sample text. To do so, use the Selection 
Tool to select text that you wish to change. Next, select the Eyedropper Tool by using the shortcut 
Ctrl+I or simply by navigating to it in the tool bar (21st from the top). Upon activating the 
Eyedropper Tool the cursor will become an eyedropper. Finally, left click the text you wish to 
sample; the initially selected text will adopt all the properties of the sampled text.  



80 
 

5.12 Using the Clipping Mask Tool 
 

On occasion you may run across situations where it would be advantageous to show a select part 
of some group of objects. One easy option is to remake the objects without the undesired content 
present. However, this approach can be tedious and sometimes detrimental (consider the case 
where you cut a complicated polygon into numerous pieces, delete the unwanted pieces, and 
then later realize you needed the whole polygon). A better approach is to use a Clipping Mask, 
which allows the user to show a select area while still keeping the group of objects intact. The 
Clipping Mask can be activated by using the keyboard shortcut Ctrl+F7 or by navigating the Object 
menu to Clipping Mask and selecting Make (image 26). 

 
 
 

 

Image 26. Navigating to the Clipping Mask Make button. 

 

To use the tool a group of objects should be selected which the user wishes to mask/clip. 
Additionally, one of the selected objects should be the intended Clipping Mask. Adobe interprets 
the object on the highest Layer or Sub-Layer as the Clipping Mask. Consider the example below 
wherein four rectangles will be masked by a circular Clipping Mask. The circle is placed partially 
overlapping the rectangles and on the highest layer (note: the fill or lack of fill is not important as 
clipping is based on the geometric area of the Clipping Mask). Upon pressing Ctrl+F7 the edges 
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of the rectangles which extend beyond the circle will be clipped from view. Also notice that the 
Layers Window changes to reflect the presence of the Clipping Mask (image 27). 

 

 

 

Image 27. Four rectangles before and after applying a clipping mask. In the Layers window the path gets renamed as 
“Clipping Mask” and a Clip Group is formed. 

 

After a Clipping Mask is formed, double clicking on any of the objects within it will allow the user 
to change the position of those objects (image 28). Clipping Masks can be released by selecting 
the Release option directly below Make in the Object menu. 
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Image 28. By double clicking any object within a clipping mask the user will be able to edit the location of objects 
within the clipping mask.  

 

5.13 Saving and inserting an image 

 

Select the file format for your application  

The most common vector formats used are Scalable Vector Graphics (SVG), Enhanced 
Metafiles (EMF), and Portable Document Format (PDF), and Adobe Illustrator (AI). Any vector-
based file can be opened and edited in Adobe Illustrator. 

The type of format to save your image depends on your application. Raster images are best for 
screen applications, such as Power Point presentations, while Vector images are best for 
inserting into professional PDF documents, for example fellowship applications. Some academic 
journals accept PDF or AI files directly, but most only accept Raster images require a high 
resolution JPEG.  

Saving a file 

To export a figure, navigate to Export under the File menu (Image 29) and select the file format 
(Red arrow). 
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Image 29: Exporting a figure as a vector image 

 

 

When exporting as a vector image, there are advantages and disadvantages to each format, 
and some are better than others depending on operating system (Mac vs PC). Below are a few 
tricks for saving as a vector image. If the exported image is not correct when inserting into a 
document, troubleshoot with the following tricks: 

o If saving as svg, convert to outlines (Image 30) 

 
Image 30: SVG save options 

 

o Check that all 3D shapes are expanded (see instructions for making a 3D shape) 
o Convert text to outlines (Image 31). Select all text, navigate to the Type menu and select 

Create Outlines 



84 
 

 

Image 31: Type menu bar 

o Make sure the original .ai file is larger than the size you want in your word doc 
o Expand again (Image 32) 
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Image 32: Expand menu 

 

5.14 Additional useful information 

Guides and Alignment 

A major advantage to Adobe Illustrator is the capacity to create objects that are quantitatively 
related to each other. This is enabled by the Vector format and the various guides build into the 
program. In this section we’ll look at the default Smart Guides, User Created Guides, and Grid 
alignment. 

Smart Guides 

Smart Guides are enabled by default in Adobe Illustrator and will offer helpful suggestions when 
manipulating objects (shapes/paths/text). For instance, when moving a square in the vicinity of a 
second square the smart guides will show when their midpoints align, when their edges align and 
when one square’s midpoint aligns with the other square’s edges. Smart Guide functionality can 
be modified by navigating the Edit menu to Preferences and then Smart Guides… (image 33). It 
can be useful to lower the Snapping Tolerance when working with very detailed sets of objects. 
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Image 33. Smart Guides tab in the Preferences dialogue box. 

 

User Created Guides 

Users can create Guides in the document that facilitate alignment. Objects will snap to these lines 
when brought within the Snapping Tolerance. To create a guide the user must first turn on the 
ruler by using the keyboard shortcut Ctrl+R or by navigating the View menu to Rulers and Show 
Ruler (image 34). Once the rulers are active they will appear along the top and left sides of the 
screen (blue arrows). To create a guide the user must click and press on either ruler and drag 
into the center of the Artboard. Doing so will generate a thin teal line which can be positioned 
freely within the composition space (red arrows). Guides can be deleted, hidden, or locked by 
navigating the View menu to Guides (green arrow). 
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Image 34. Creating and editing user created Guides. 

 

Grid Alignment 

It is also possible to align objects to preset grid lines in Adobe Illustrators. These can be activated 
by navigating the View menu to Show Grid or by using the keyboard shortcut Ctrl+” (purple arrow 
in image 34). The Grid can be edited by navigating the Edit menu to My Preferences and Guides 
& Grid… (image 25). 

 

 

Image 35. Navigating to Guides and Grid… – notice the grid in the background. 

 

As can be seen in image 36, the Guides and Grid tab of the Preferences dialogue box allows the 
user to control the spacing between major gridlines (blue arrow) and minor gridlines (red arrow). 
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Image 36. Guides and Grid tab of the Preferences dialogue box. 
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6 CrystalMaker 
Point person: Tawney Knecht (tknecht@uoregon.edu)  

6.1 Download Information 

• Go to https://researchguides.uoregon.edu/chemistry/software for general instructions 
• Click on link “Download from CrystalMaker” 
• Download CrystalMaker, CrystalDiffract, and SingleCrystal from the CrystalMaker 

website.  
• Obtain site license information from the Science Library. Contact: Annie Zeidman-

Karpinski, annie@uoregon.edu 

6.2 Online Tutorials 

This primer will go through how to open .cif files, view and manipulate crystal structures in 
CrystalMaker. More comprehensive CrystalMaker tutorials are online on the CrystalMaker 
website. Please consult these to gain more familiarity with this crystallography software. 

Tutorials are found here: http://crystalmaker.com/crystalmaker/video-tutorials/index.html 

 

6.3  Opening a Structure 

 The Structures Library 

When you download CrystalMaker, you will get access to a library of structures. From this 
library, you can access basic structure types and then edit the structures to include the 
desired atoms. Browse through your library to see what structures are available.  

 ICSD 

More often than not, the crystal structure you need already exists in the Inorganic Crystal 
Structure Database (ICSD). Go to the ICSD website (https://icsd.products.fiz-
karlsruhe.de/) and click on “LOGIN to ICSD” in the top right corner of the screen. This 
should bring you to this page: 
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Enter the desired atoms in your structure in the “Chemistry Composition” line (separate 
elements by spaces), and restrict the number of elements in the following “Number of 
Elements” line. In the example above, the structure for CeO2 is being searched for, so “Ce 
O” was entered in the chemistry composition line, and the number of elements was 
restricted to 2.  

Click “Run Query,” and this will generate a search. 

 

Check the box next to the desired structure and then click “Show Detailed View.” If this 
structure is indeed the structure you want to open, click “Export Cif” in the top right corner. 
This will download the .cif file, which can be opened in CrystalMaker. 

6.4 Viewing Crystals 

• To rotate the crystal, simply click to “grab” the crystal and move your cursor around. 
• Hold SHIFT and click and graph the crystal to only rotate in the axis perpendicular 

to your screen 
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• You can also rotate using the  icon in the toolbar. 
• View your crystal along a certain direction by clicking the orient  icon and typing 

in the facet you want to view. In the below example, the 110 facet was entered as 
the View Direction 

 

• Change the model by clicking on the “Model” in the top toolbar. Here you can select 
a number of model options. 

 

• Change the size of your structure by clicking the Range icon. Here, you can: 
o Expand or Contract range: this expands/contracts the structure equally in 

all directions 
o Enter specific axial range limits along various axes 

 

• Turn your structure into a cluster or nanocrystal by clicking on Cluster. 
o Enter in your central atom 
o Enter in the desired radius 
o Click “Reset Cluster Size” 
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6.5 Changing Atom Colors, Radii, and Bonds 

• To bring up the necessary menu, click on Inspector  in the top right corner of 
the screen. The following menu should appear, if not already visible: 

 

• Click through these to see what they can do. 
• To change atom color and radii, click on the second icon with the sphere and 

pyramid. 
o Edit the radius (if ever necessary) in the column “r[Å]” 
o Edit the color in the column “Col” 
o Edit the atom style in the column “Style and Label” 
o And so on… 

 

• To change bond type, click on the  icon 
o Click on the 3D image of the bond to edit the bond type and appearance 
o And so on… 
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6.6 Exporting Images 

To export graphics, go to FileàExport Graphicsà2D Graphics 

 

Select the desired settings and save as prompted. 
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7 Additional Resources 
 

Please refer to the University of Oregon Science Library Research Guides website 
for more information on several useful databases and software: 
https://researchguides.uoregon.edu/chemistry 

 

7.1 Software 

• Avogadro 
• Crystallography 

o Mercury 
o GSAS 

• Dropbox 
• Figures 

o GIMP 
o Inkscape 

• Graphing 
o Origin Pro 
o MagicPlot 

• ImageJ 
• Reference managers (specific ones may be preferred by some labs) 

o Endnote 
o Mendeley 
o Zotero 

 

7.2 Databases and Online Resources 

• Cambridge Structural Database (CSD):  
https://www.ccdc.cam.ac.uk/structures 

• ChemSpider:  
http://www.chemspider.com/ 

• Inorganic Crystal Structure Database (ICSD):  
https://icsd.products.fiz-karlsruhe.de/ 

• NIST Chemistry Webbook:  
https://webbook.nist.gov/chemistry/ 

• Scifinder:  
https://scifinder.cas.org/ 

• Spectral Database for Organic Compounds (SDBS):  
https://sdbs.db.aist.go.jp/sdbs/cgi-bin/direct_frame_top.cgi 

• Web of Science:  
https://apps.webofknowledge.com/ 
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8 Shannon Boettcher Lab Guide 
 

1. I like students to use Endnote for references. They often use a mishmash of other software 
that can’t get all the formatting correct. Endnote is not ideal in many ways, but it does the 
formatting right and is what most folks use.  
 

a. I have a journal abbreviation library that can be imported and takes care of all the 
journal abbreviations. 

b. Sentence case for reference titles unless otherwise noted by Journal style 

  

2. Since we have illustrator as a standard software all students should just learn how to use 
it. Photoshop is not really that important since we don’t manipulate photos when we 
publish SEM etc. 

  

3. Graphing – we use Origin. It requires an expensive license but is very user friendly, so 
students will get access instructions during their rotation. 

  

4. For plotting etc. 

a. no serif fonts 

b. font sizes commensurate with other in the journal article (i.e. 6 pt or larger) 

c. close in borders around graphs 

d. don’t use legends unless absolutely necessary, label data directly on plot instead 

e. take into account colors for contrast and for color blind folks 

f. graphs should be readable when printed in black and white 

g. effective use of white space with insets, illustrations etc. 

 

5. Graphics 

a. No excessive use of 3D shapes just for the sake of it 

b. Use simple clean line art for most cases 
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9 Carl Brozek Lab Guide 
General Expectations: 

● You are expected to help maintain a good safety culture by adhering to requirements 
and reminding others about requirements when necessary. 

● During the COVID-19 pandemic, you are expected to show up for your scheduled shifts. 
If you will not be in the lab for the majority of your shift, the shift should be marked 
available with as much advance notice as possible. 

● When the pandemic subsides, you are expected to be in the lab or office during normal 
working hours if you do not have class or teaching responsibilities. 

● Do not work in the lab alone.  

● You are expected to ask questions! Don’t stay silent about things you don’t understand. 
Anyone in the lab will be happy to help you. (Ask your direct mentor first though.) 

Software Needed: 

• General: Microsoft Office 
• Graphing and Figure Making: Igor Pro, ChemDraw, Vesta, Adobe Illustrator 
• Data Interpretation: MestreNova, EVA 
• Crystallography: CrystalMaker/CrystalDiffract, Mercury, GSAS 
• Reference Manager: Zotero/Mendeley 
• Also have: A Scifinder account, a RSS Feed Reader (Newsblur, Feedly, Old Reader) 

Figures: 

Igor: 

• Axis Options: No axis standoff, mirror axis (no ticks) 
• Auto/Man Ticks: Check minor ticks 
• Ticks and Grids: Major Length 3.5 
• In Graph options: Width: Absolute 3.5, Length: Aspect 0.62 
• In Modify Trace Appearance: change trace color from bright red. If you are graphing 

data at particular points, rather than a continuous trace, choose “line with markers” and 
use circular markers. 

• To label traces: Use “Annotate Graph” and drag your labels close to the data. Do not 
use legend. When there are multiple labels, align them nicely. 

• When you have these general settings (No axis labels yet), go to Graph/Capture Graph 
Pref… to save these preferences for all eternity. 

Adobe Illustrator: 

● Figures should follow the standard group guidelines: 3.25-in wide panels with 0.62 
aspect ratios, 9-pt Arial font throughout, 0.5 pt line thickness, minimize dead white 
space, and ask yourself “does my figure clearly convey the message?” 

● Start by making your artboard the appropriate size for the figure you are making i.e. 
single or double column. 
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● Color choice should be unsaturated, color-blind friendly, and HTML-friendly. Use 
consistent color schemes. 

PXRD: Y Axis: Intensity (a.u.) No ticks or numerical labels necessary. X Axis: 2\F’Symbol’q 
\F’Arial’(°) *The degree symbol is in “Characters”. Stacked your patterns, do not overlay them. 
Two methods to accomplish this: 

a) When New Graph, choose to put all y waves on a different y axis. Then, in Axis Options, 
use “between % and %” to move the traces up and down. Don’t leave axis gaps. 

b) Put all patterns on the same y axis in New Graph. Then, in Modify Trace Appearance, 
check “offset” and use the y axis offset to move the traces up and down. You can 
additionally use y% to increase or decrease relative intensity. 

Plot against a simulated or expected powder pattern. Label with Miller indices if appropriate. 

IR: Overlay normalized IR spectra. Label with the appropriate names for each trace. Annotate 
traces with the important bands of the material. Overlay traces with target material, starting 
materials, or other related compounds. 

UV-Vis: Overlay normalized UV-Vis spectra after correcting for lamp shifts. Label with the 
appropriate names for each trace. Annotate traces with the important transitions. If looking at a 
transition metal-complex conduct ligand field analysis as necessary. For diffuse reflectance 
data, use the Kubelka-Munk function to transform the reflectance into absorption. The Y axis 
should then read “Normalized F(R) (a.u.)”. For general UV-Vis x-axis is in wavenumbers with 
increasing energy towards the left. Tauc plots use eV as the x-axis.  

Chem Draw: Use to draw reaction schemes. General settings: ACS Document 1996, line 
thickness 0.0118 in. Include reaction conditions, all relevant counterions, and side products. The 
reaction should be balanced. 

VESTA: Use VESTA style file. Make sure you can see the structure clearly. A good way to do 
this is look at the structure from a, b, or c, then use the arrow keys to rotate it off-axis in one 
direction. Use the “Boundary” function to play with how much the material is visible. You should 
see enough of the structure to see the topology clearly, while also still be able to see detail. 
Delete all dangling bonds. 

CrystalMaker/CrystalDiffract: Use CrystalMaker/CrystalDiffract to view crystal structures of 
materials that you have a .cif file for, or to simulate powder patterns. Open your .cif file in 
CrystalMaker and go to Calculate > Powder Diffraction > New Pattern. This will open 
CrystalDiffract. From here, note the indexed peaks and File > Export Diffraction > Profile. Load 
in Igor as a .txt file.  

Presentations: 

• Use an Assertion/Evidence style talk to make your story clear. Titles are assertions: 
the key conclusion of the slide. Evidence is the figures and minimal text on the body 
of the slide. 

• When presenting characterization data for a product, the chemdraw scheme for the 
reaction by which the product was made should be at the top of the slide. 

• Include relevant citations in ACS style at the bottom of the slides. Include all authors; 
do not use “et al.” 

Monday Morning Meeting: 
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• Have at least one fully updated E-notebook page to share in MMM 
• Title pages with physical notebook code (Ex. CK1-001) and a short description 
• Include a balanced reaction scheme from ChemDraw 
• Include a reaction table and a procedure 
• Include at least one worked-up figure of data you collected 
• Be prepared to discuss data interpretation / conclusions, and your plans for the 

upcoming week 

Lab Notebooks and Record Keeping: 

The purpose of the physical notebook is to be a complete record of everything you do in lab. 

Every experiment should include: 

• A descriptive title 
• A purpose 
• A reaction scheme 
• A table of the reagents used (Molecular weight, Amount, Moles, Equivalence, etc) 
• A detailed procedure 
• Characterization section indicating what measurements were done, on what 

instrument, and the file name and location. 
• Conclusions (Yield, Success/Failure, etc)  

Use of the enotebook: 

• Every experiment should include the same sections as the physical notebook. It is 
advantageous to write out formal procedures for future use.  

• Reference relevant papers.  
• Upload images from Chemdraw for your reaction schemes. 
• Upload photos and pictures of data collected and add them into the e-notebook 

pages. Caption all items clearly and descriptively.  
• Update your experiment status accordingly. IE don’t leave all your experiments as “In 

Progress.”  

When attaching data to show in the enotebook scroll down the page to the Attach a file box > 
click then upload the appropriate file as either a .jpeg or .png.> then scroll to Attached files and 
click insert at cursor position > resize image as appropriate. 
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10 Amanda Cook Lab Guide 
Cook Lab Software Summary  

The primary pieces of software that we use are ChemDraw and MestreNova. Below are examples 
of reaction schemes and NMR analysis that are presentation-ready. Also included are specific 
expectations for PowerPoint presentations (including information on graphing data).  

 

 



100 
 

11 Mike Haley Lab Guide 
 

Data Plotting: 
• Font: Arial 
• Font sizes should be legible from arms-length away for most figures, generally 10pt at 

minimum  
• Make Excel fonts black, and borders black and bold enough 

o Depending on figure, major tick marks on axes should face out and minor tick 
marks do not have to be included 

• Make lines/curves in most plotting programs 1.5pt or 2pt to help them stand out 
 
Figure Making/Presentations (and how to give a talk): 

• Powerpoint preferred (though not mandatory) 
• All ChemDraw structures must be the same size 

o Copy/paste then expand all by the same percent (typically ca. 120-150% size) 
o Also make sure to paste all as images or all as ChemDraw embedded files, not a 

mix 
• Slide titles should be a short description of the key point a slide is trying to make 
• All slides should have at least one figure 

o Animations, boxes, and arrows can help break down bigger figures or tables and 
guide the audience as well as the speaker.  

o Do not go overboard with the animation (max 3-4 per slide) 
• Keep words to a minimum 

o Bolding key words in longer sentences can help if long statements need to be 
added (i.e., quotes, long definitions, etc.) 

• References at bottom of each relevant slide, use consistent style and consistent font size 
• Use simple slide styles - wouldn’t hurt to make your own template to use throughout grad 

school. No dark backgrounds as it makes lettering hard to read 
 
Routine Software (most are available at https://software.uoregon.edu/ with a UO account): 

• ChemDraw (structure drawing) 
o ACS Document 1996 style template 

• SciFinder - not software, but not everyone knows how to use it 
• MestreNova (NMR processing) 

o Make fonts big enough (change from default) 
o Delete the background grid 
o Change x-axis label to “chemical shift (ppm)” 

• File transfer program 
• VPN 
• MS Office 365 
• Other possible software 

o Avogadro 
o Mercury (x-ray structures) 
o Vesta 
o Zotero/Mendeley (literature managing software) 
o Talapas account (UO supercomputer) 

• Chemistry reference resolver is a very helpful tool! 
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Standard Skills: 
• Make subgroups in ChemDraw (watch out for copy and paste errors) 

o Yields on all reactions 
o ChemDraw in ACS format 
o Have NMRs of all reactions ready to show 
o Also have starting material NMRs ready for comparison 

• Lab notebook/record keeping 
o Draw reactions 
o Have quantities table 
o Write out procedure and yields, you want to write down enough to be able to look 

back and repeat it easily 
• If making a new compound be mindful of characterization 

o Always obtain clean 1H, 13C NMR spectra 
o Save some of the clean sample for MS 
o Other NMR if applicable (e.g., 31P), and other characterization (e.g., UV-Vis, 

fluorescence) of final compound 
• Get NMR training from Nanette (can register for training online) 

o Especially with Icon NMR 
 
Graduate School and Professional Skills Beyond Research: 

• How to make a CV 
o Best way to learn is to look at examples from bosses and mimic their style 
o Each CV tells a story. Organize the sections based on relevance (i.e., education 

history, then research experience, then professional experience, then 
extracurricular experience, and so on) 

• How to write a manuscript 
o First and foremost, know that it isn’t something that is quick and easy 
o Go onto the website of the journal that you are going to submit to and check early 

and often for formatting/length requirements 
o Outlining a manuscript is a great way to figure out what figures you may need, as 

well as what references you may need for key points each section wants to make 
o Emulating previously published papers from the lab (but not plagiarizing) is a good 

start 
o Start on the supporting information document early so you can make sure you have 

all the characterization you need to submit. If you do this too late, then you will 
have to wait on benchwork to submit instead of finishing it off while writing 

o Ask your peers (in your lab or not) to help develop ideas and edit drafts. The more 
refined of a draft you give to your PI, the better it will turn out in the end 

 
General Expectations: 

• When not teaching/in class most school day hours we expect to see you in lab 
o Could be grading or studying, but do it at your desk in lab (though likely this can 

happen only when the covid pandemic subsides) 
• Mistakes are OK since they are a part of learning anything 

o Ask those around you how to avoid the mistake and build your knowledge from 
that experience 

• In our lab, people are expected to be receptive and respectful to other people’s opinions 
and such 

o We strive to cultivate a positive lab environment and reach compromises on any 
decisions that may have driven a wedge between people in lab 
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o If something makes you feel uncomfortable, whether it be a reaction or something 
said, please let us know and we will work through it and resolve it however is best 

• A good rule of thumb is that if you are not sure about the safety of something, then ask 
someone else first 

o Though we have a formal “safety officer”, everyone in lab is more than capable of 
answering these questions and/or giving the required trainings 

o Do not work in lab alone 
• General schedule 

o Subgroup happens once per week, runs ~1 h 
o Group meetings happen once per week (often Wednesday night), run ~2 h 
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12 Ramesh Jasti Lab Resources 
Making Figures  

Fluffy style  

 

1. Create .pdb file in avogadro  

2. Open in QuteMol and save as a .png  

3. Open in photoshop and color  

a. Use the "Quick Selection Tool" to select what will be a certain colour  

b. Color by adding a Hue/Saturation layer and selecting colorize  

Rotating GIFs 

 

1. Open in QuteMol  

2. Save as rotating .gif, use between 100 and 200 as spin speed  

 Alternative  

1. Open as a .pdb file in Mercury  
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2. Click animate and begin the molecule spinning  

3. Use Screen to GIF to record the molecule spinning  

Opaque molecules  

 

1. Copy ChemDraw into PowerPoint  

2. Use the freeform drawing tool to outline the front shapes that will be opaque  

3. Copy these shapes back into ChemDraw and fit them into place  

4. Send the shapes to back and then send all bonds that should be blocked by the front 
shapes to back  

5. Go back to PowerPoint and draw the back shapes  

6. Copy them into ChemDraw, fit them into place and send to back  

Nanotubes  

 

1. Open Avogadro and find the "Nanotube Builder" tool  
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2. Insert the desired chiral vectors and select the desired length (15 A is good for tubes, 
3 A makes a CPP)  

3.  

4. Do not minimize, save as a .mol file  

5. Open in ChemDraw and orient to preferred perspective using the Structure 
Perspective tool  

6. Flatten the molecule and ensure all front bonds are in the front and back bonds are 
in the back  

7. Bold all front bonds  

Orbitals  

 

1. Open ChemDraw file in Spartan  

2. Minimize the structure  

3. Do a calculation from Setup>>Calculations (Energy at Ground state with Semi-
Empirical AM1 from Current geometry is quickest)  

4. Go to Setup>>Surfaces and click Add. From here pick the surface you want and set 
the resolution to as high as possible  

5. Go to Model>>Line  

6. Then deselect hydrogens in the same menu  

Large molecules  
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1. Draw the molecule using ChemDraw (for fullerenes, see Schlegel diagrams) and 
save a .mol file  

2. Open in Avogadro, minimize using the MMFF94 forcefield, and save as a .mol file  

3. Open in ChemDraw and orient to preferred perspective using the Structure 
Perspective tool  

4. Flatten the molecule and ensure all front bonds are in the front and back bonds are 
in the back  

5. Bold all front bonds  

Things on surfaces  

 

1. Open surface crystal structure in Mercury and extend the crystal plane in the 
appropriate directions (Calculate>>packing/slicing) to form a surface  

2. Save as a .pdb  

3. Do same with object to be placed on surface  

4. Open both in avogadro and copy one structure into the other and position  
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13 Darren Johnson Lab Guide 
Software to have downloaded (and is free) 

• Microsoft Word 
• Microsoft PowerPoint 

o For subgroup and group meeting presentations 
• Microsoft Excel 

o For data analysis 
• Microsoft OneNote  

o For our online notebooks 
• ChemDraw 

o For drawing all chemical structures 
• MestreNova  

o For NMR analysis 
• Avogadro 

o For simple chemical structure optimization 
• Adobe Illustrator 

o For figure creation 
• Matlab 

o For data analysis 
• CiscoConnect 

o To access the VPN when you are off-campus 
• WinSCP 

o To access NMR files 
• Dropbox 

o Free through the University. Generally good to have things backed up. 

 

Group Meetings (~1.5 hours, once per week) 

Our group meetings are divided into 4 sections: 

• Good news 
o People are encouraged to share their good news from the week, whether it is lab-

related or not 
• Lab business and safety 

o Anyone can bring up a lab business or safety concern 
• Equity and Inclusion 

o Topics of equity and inclusion are discussed every week, whether it is lab-related 
or not 

• Scientific talk 
o Length varies for purpose of talk. Rotation students will be expected to give two 

15-minute presentations throughout the term. The first presentation will be at the 
beginning of the rotation, outlining the project motivation and expected research 
plan. The second presentation will be at the end of the term and serve as a practice 
rotation talk. 
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o At the beginning of our group meeting presentations we include a brief ‘life update’ 
in which we can talk about updates in our lives, or introduce ourselves if we’re new 

 

Subgroup (~1 hour, once per week) 

For subgroup we meet in smaller groups with the other researchers on our project. We talk about 
what we’ve done the previous week, problems that have occurred, and plans for the next week. 
Subgroup is to ask questions and get help on places that you’re stuck. Subgroup is also to keep 
the group informed of your research progress. Come prepared with your data in a way that is easy 
to talk through. For example, you could make an informal PowerPoint with a synthetic scheme 
showing a reaction that you just ran and the NMR of the reaction mixture. 
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14 David Johnson Lab Guide 
Typical DCJ lab projects involve synthesizing a thin film, 

following its evolution as a function of annealing temperature, 
and measuring the electrical properties of the material. One of 
the most common figures we make is of stacked x-ray diffraction 
patterns graphed as a function of annealing temperature (Figure 
1). The patterns are stacked so that the lowest temperature 
annealed sample (the as-deposited) is at the lowest intensity and 
the highest temperature annealed sample is at the highest 
intensity to enable a clear comparison of changes with increasing 
temperature.  From a stylistic perspective, we prefer the patterns 
to be the same color (black) when comparing the same sample 
at various temperatures. If comparing several different samples 
at the same temperature, then different colors may be used to 
add clarity to the discussion. The line width (1.5) should be consistent for each pattern. The 
patterns should be spaced so that the reflections in different patterns do not overlap and there is 
space to indicate the annealing temperature or sample identification, usually on the right side if 
the pattern allows for it. The font should be Arial with the axis titles and temperatures as 14-point 
font and the x-axis, Miller indices, and legend at the top as 12-point font. The Miller indices are 
indicated via normal, bold, or italic fonts for different phases. It should be noted that the intensity 
is arbitrary so there are no numbers or tick marks on the y-axis for these graphs. Units are 
indicated after the axis description with a “/”.  

a. b. c.  

Figure 2: Examples of other common DCJ lab figures: amounts of material (a), composition of 
binary samples (b), and resistivity as a function of temperature (c).  

For a presentation especially, figures are better tools than tables to illustrate data. 
Examples include amounts of material as a function of annealing temperature, composition as a 
function of film thickness or annealing temperature, and electrical properties such as resistivity 
and Hall effect.  The same font guidelines apply to these figures. Additionally, markers should be 
7.0 in size. In Figure 2a, the amounts of material in a single precursor are followed as the sample 
is annealed to higher temperatures. The different colors indicate the different elements in the 
sample but the same color should be used for both the line (theoretical amounts of one element) 
and the markers (experimental amounts of that same element). Colors are important to indicate 
different samples or different elements in the same sample and should be used to add clarity to 
the discussion of the data. The David Johnson lab (DCJ lab) primarily uses MagicPlot as its 
software of choice when figure making. The student version is free to download online and is user 
friendly to store and plot data.   

 

Figure 1: In-plane x-ray 
diffraction as a function of 
temperature. Example of a DCJ lab 
quality figure.  



110 
 

15 Mike Pluth Lab Guide 
Writing a paper in the Pluth Group 

Preparation 
• Make a folder in your shared Dropbox with the following folders: 

• Figures 
• Drafts 

• Disable auto-compression in the main manuscript 

  
 
During writing 
• When writing: 

• Avoid editing directly in Dropbox to avoid file conflicts 
• Lab members should read and edit manuscript versions before sending to Mike 
• Communicate with Mike when to ask him to look at new things 
• Follow general formatting guidelines for target journal when relevant 

 
Finalizing and Submitting 
• Create the following files: 

• Endnote file (specify date of generation) 
Note: always be careful of journal endnote templates 

• Word file with suggested reviewers (name, email, and institution) 
• SI containing relevant data, including NMR spectra of all new compounds 
• Generate figures in Illustrator, and ensure that content is editable (i.e. text is editable 

text rather than vector lines). Save as compressed TIFF, and then resize in 
Photoshop. Make sure all files are editable, and that any linked images are in the 
shared Dropbox folder 

• Chemdraw figures do not need to be in Illustrator. Make sure to have a Chemdraw 
file in your Figures folder if you are using a Mac. 

• Print out all images to determine figure/table legibility 
• Consider font sizes, line weights, and colors 
• Images in manuscript draft should be sized to final journal sizes 
• Work on figures and schemes early and get feedback from other lab members. Think 

about the most concise way to display content. Your should strive to make the best 
figures possible 

• For revised manuscript, use the template for responding to reviewers in the Dropbox folder 
 

 


